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Chapter 1 

Product Components and Capabilities 1 

Overview 
Manageware for Documentum, also known as BMC Performance Manager for Documentum 
contains specific knowledge about your Documentum system in the form of command 
descriptions, applications, and parameters. The Manageware solution uses this information to 
monitor the health and welfare of your Documentum system. 

Product Features 
Manageware for Documentum ensures maximum availability and performance by helping 
administrators proactively identify and fix system problems before they affect end users. 
Manageware for Documentum: 

• provides a centralized and simplified view of the entire Documentum environment for 
faster problem detection and resolution 

• monitors availability of the Documentum eContent Server and all Docbases 
• tracks the number of completed, failed, and aborted jobs for each Docbase 
• monitors the file system capacity of the file stores 
• provides system metrics on key Documentum processes 
• monitors key Documentum log files 
• reports the number of active, inactive, and idle users 
• monitors Docbase connectivity from remote clients 
• measures end-user performance from the client machine to the Docbase by simulating 

client transactions such as check in, checkout, connect, disconnect, import and delete 

Manageware for Documentum at a Glance 
This section briefly describes the monitoring environment, architecture, and components of 
Manageware for Documentum. 

• The Console provides the graphical user interface to the PATROL monitoring 
environment. What you choose to monitor in your environment is limited only by what 
products you choose to install. 

• The Agent collects statistical performance data for all parameters specified to it through 
loaded PATROL products. 

• The Manageware for Documentum KM contains the specific knowledge necessary to 
monitor critical information about your Documentum environment. With Manageware 
for Documentum, you can monitor the health and availability of your Documentum 
eContent Servers, DocBrokers, Connection Brokers and Docbases. 

 

Navigating Manageware for Documentum Classes and Instances 
The Manageware for Documentum knowledge module uses a hierarchy of application classes to 
gather specific information about your Documentum environment. To access the information 
from these application classes, their instances, and their parameters, simply open them by double-
clicking to drill down to the view you want. 
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Console Views of the Documentum KM 
The main map level is shown in Figure 1-1. This top level container holds the Documentum 
Docbase and performance application classes, as well as the database class. 
 
Figure 1-1 Manageware for Documentum Main Map 
Opening a Docbase icon displays the specific Docbases being monitored. Opening a specific 
Docbase icon displays the application classes for the file store, processes, Docbase, jobs, and 
users, as shown in “Docbase Application Classes” 
 
 

 
 
 

 
Figure 1-2 Docbase Application Classes 
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Application Class Hierarchy 
Manageware for Documentum application class hierarchy, labeled with each application class 
name. 
Figure 1-3 Application Class Hierarchy of PATROL for Documentum 
 
 

 

Application Class Descriptions 
Manageware for Documentum contains a server implementation and a client implementation. 
Table 1-1 shows the icon for each application class used by the Documentum KM Server, its 
application class name, its parent application class, and a brief description of its function. Table 
1-2 shows the same for the Documentum KM Client. 
 
Table 1-1 Application Classes for Manageware for Documentum – eContent Server Components 
Icon Application Class Function 
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* DocBrokers – Also known as Connection Brokers  
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Table 1-1 Application Classes for Manageware for Documentum – eContent 
Server Components Icon Application Class Function 
Table 1-2 shows the icon for each application class used by the Documentum KM Client, its 
application class name, its parent application class, and a brief description of its function. 
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Component Files List 
The server and client implementations of the Documentum KM each contain their own list file so 
that only one file for each component needs to be loaded into the PATROL Console. The 
individual .km component files for server and client implementations are listed below. 
 
KM List files for Server Components: DM_Documentum.kml 
• DM_BROKER.km 
• DM_BROKER_CONT.km 
• DM_COLLECTORS.km 
• DM_DATABASE.km 
• DM_DB_CONT.km 
• DM_DOCBASE.km 
• DM_DOCBASE_CONT.km 
• DM_DOCUMENTUM.km 
• DM_FILESTORE.km 
• DM_FS_CONT.km 
• DM_JOBS.km 
• DM_PERF.km 
• DM_PERF_CLIENT.km 
• DM_PERF_CONT.km 
• DM_PROC_CONT.km 
• DM_PROCESS.km 
• DM_USERS.km 
 
KM List files for Client Components: DM_Client.kml 
• DM_CLIENT.km 
• DM_COMM.km 
 
 

Chapter 2 

Installing Manageware for Documentum 2 
 
This chapter provides information that you need to install the Manageware for Documentum 
knowledge module. 
Pre-loading the KMs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21 
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Installation Workflow 
A typical workflow for installing Manageware for Documentum consists of preparation, the 
actual installation, and configuration tasks, as illustrated in Figure 2-1. Optional steps are in 
dashed boxes. 
Figure 2-1 Installation Workflow 
 

. 

Preparing to Install 
Manageware for Documentum is made up of three components: a server installation, an optional 
client installation, and a console KM installation. During a single installation session, you can 
install multiple products to multiple servers and clients, varying the product mix for particular 
computers depending on your needs. Consequently, some advance planning is needed. 

Determining Where to Install the Software 
As discussed in Chapter 1, “Manageware for Documentum at a Glance,” the Console provides the 
user interface to your system, the Agent works in the background to obtain and deliver data about 
your system, and the PATROL knowledge module tells the Agent what to gather and the Console 
what to monitor in your Documentum environment. To successfully install the KM, you need to 
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know which PATROL components to install and where to install them. You should install one 
KM on each eContent server. 
 
Diagram Your Current Documentum Environment 
You may find it helpful to create a diagram of your present Documentum environment and 
compare it with the example below in Figure 2-2. This simplified example shows Documentum 
servers organized by function, along with the PATROL products you need to install on them. The 
same information is provided in list form following the examples. 
 
Figure 2-2 Example Configuration for Test Environment 
 

 
 
 
Where to Install Software Components Based On Host Function 
The example above in Figure 2-2 gives a picture of where to install the Documentum KM and 
other required software. The section below provides the same information in list form. 
Documentum eContent Servers—At least one Documentum server in the configuration must have 
installed 
 
• Documentum 4i V4.1, 4.2.x, 5.2, 5.3 eContent Server 
• PATROL Agent (UNIX) 
• PATROL Console (optional) 
• Manageware for Documentum 
• Console KM (optional) 
• eContent Server Components 
• PATROL Knowledge Module (KM) for Unix 
 
Documentum Desktop Client hosts—Any client machine that you plan to use to view and manage 
the data collected by the PATROL Agents must have 
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• Documentum 4i V4.1, 5.2, 5.3 Clients for Windows NT 
• PATROL Agent (Windows NT, 2000) 
• PATROL Console (Windows NT, 2000) 
• PATROL for Documentum 
— Console KM 
— Desktop Client Components 
Note 
You are strongly recommended to replicate the production environment on a test machine before 
you begin installation. 

Verifying System Requirements 
Table 2-1 shows the operating system, database and PATROL Agent and 
Console versions that are supported by Manageware for Documentum – 
Be certain to verify that you have the necessary software. 
 
Table 2-1 Supported Platforms for Manageware for Documentum - eContent Server Components 
eContent Server 
 
OS DCTM version DB version Patrol Agent 
Solaris – 2.7,2.8,2.9.2.10 4.X,5.X 8.1.7,9.2.0 3.4,2.5,3.6 
HPUX – 11.0 4.x,5.x  8.1.7,9.2.0 3.4,3.5,3.6 
WINTEL W2k,W3k 8.1.7,9.2.0 3.4,3.5,3.6 
 
* NOTE – Manageware for Documentum uses the /PS_SHARE agentnamespace variable. Please 
consult your BMC Software PATROL Agent documentation to see that your Patrol Agent version 
has been patched. 
 
Table 2-2 shows the operating system and PATROL Console versions that are supported by 
Manageware for Documentum – Desktop Client Be certain to verify that you have the necessary 
software. 
 
OS DCTM Version Patrol Agent 
WINTEL W2k,W3K 4.x,5.x 3.4,3.5,3.6 
   
 

Setting Up Documentum to Use PATROL 
In order to prepare your Documentum installation to work with the Manageware for 
Documentum knowledge module, you will need to: 

• make PATROL a Documentum user, and  
• add the target hosts into the Documentum dmcl.ini file. 

The tasks that follow show you how to do this. 

Making PATROL a Documentum User 
Summary: In order to execute IDQL queries and run DocBroker utilities, the PATROL Agent 
that is running on the Documentum server must be a member of the Documentum User Group. 
Use this procedure to add the PATROL Agent account as a Documentum User. 
 
Before You Begin 
Ideally, the PATROL User should have the following attributes: 
• be a member of the admingroup 
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• have system administrator privileges 
• have client administrator privileges 
Note 
See your Documentum product administrator documentation for information about adding users 
to a Docbase. 
 
Sample PATROL User Setup in Documentum 
The example below in Figure 2-3, “Adding PATROL as a Documentum User” on page 2-8, was 
created by connecting to the appropriate Docbase using the Documentum Administration tool and 
choosing the User “Add” option. 
 

 
 
Sample PATROL User Setup in Documentum using IDQL 
 
Login to IDQL 
 
1> create dm_user object 
2> set user_name='patrol', 
3> set user_password='patrol',  
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4> set default_folder='/patrol', 
5> set user_login_name='patrol' 
6> set user_privileges=8 
7> go 
object_created   
---------------- 
 

Adding Server Hosts to the Client Initialization File 
Summary: If you will be installing the Documentum KM on your Desktop Client hosts, you 
must add the host name of the eContent Server to the dmcl.ini file. 
 
 
Before You Begin 
• Identify the Desktop Client host machines that will act as Manageware for Documentum clients. 
• Verify that these client machines have the Documentum Desktop Client installed. 
 
Note 
See your Documentum 4i product administrator documentation for information about installing 
Documentum Desktop Client. 
 

Adding Target Host Names to dmcl.ini 

» For each Desktop Client machine, edit the “host =” directive of the dmcl.ini file so that it 
points to the host name of the eContent Server where Manageware for Documentum is running. 
The dmcl.ini file is located on the Desktop Client machine under the \Winnt directory for both 
Windows NT and Windows 2000. 
 
In the example shown below, the eContent Server name is erpsun1. 
#Default DMCL.INI. Refer to DMCLFULL.INI for other options 
# Assuming No Network File System 
# Assuming No Compression for Content Tunneling 
[DOCBROKER_PRIMARY] 
host = erpsun1 
[DMAPI_CONFIGURATION 
cache_queries = T 

Installing PATROL for Documentum 
Manageware for Documentum contains three components, a server component, a client 
component, and a console KM component. The server component is installed on your 
Documentum eContent Server. The client component is installed on your Documentum Desktop 
Client. The console KM component is installed on your PATROL Console machine. 
 
Manageware for Documentum Component Names 
The server component is named Manageware for Documentum – eContent Server Components. It 
is installed only on Unix platforms. The client component is named Manageware for 
Documentum - Desktop Client Components. It is installed only on Windows NT/2000 platforms. 
The 
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PATROL Console component is named Manageware for Documentum - Console KM. It can be 
installed on either Unix or Windows NT/2000 platforms, wherever you have installed a PATROL 
Console. 
 
Procedures in This Section 
The procedures in this section show you how to install Manageware for Documentum on your 
eContent Servers and Desktop Client hosts. Each procedure also shows you how to install the 
Console KM on a local PATROL Console. The procedure that follows the server installation 
shows you how to set directory permissions so that you can collect metrics on file system usage. 
 

Installing Manageware for Documentum on an eContent Server 
Summary: In this procedure, you will install Manageware for Documentum on an 
eContent server. If you have a PATROL Console installed on your server, you can also install the 
Manageware for Documentum Console KM on the server at the same time. 
Before You Begin 
• The PATROL Agent and Console must be installed and running. 
 
Confirm that $PATROL_HOME Exists 

» Confirm that the $PATROL_HOME environment variable exists. 
You can use the echo command at the command prompt to make this verification. 
Example 
$ echo $PATROL_HOME 
ff/usr/site/dm/dminstall/Solaris28-sun4 
Note 
$PATROL_HOME is the Unix environment variable that identifies the home directory for all 
PATROL files. 
 
Download/Obtain PATROL for Documentum 
Download/Obtain the Manageware for Documentum files from the ESI, if you haven’t already, 
and extract them to $PATROL_HOME installation directory. 
 
Step 1 Extract the KM file using command 
tar -xvf DCTM_Agent.tar  
To the $PATROL_HOME directory 
Unix Example - /opt/bmc/Patrol3  
 
If wintel use winzip 
 
Wintel Example – c:\Program files\BMC Software\Patrol3 
 
The compressed installer will begin extracting its installation files into a $PATROL_HOME  
 

Pre-loading the KMs 
Summary: In this step, you will pre-load the client component of PATROL for Documentum. 
ESI recommends that you pre-load the client component of PATROL for Documentum. To verify 
that DM_CLIENT.kml is pre-loaded, use these guidelines. You can find detailed information in 
the Preloading Applications section of the PATROL Agent Reference Manual. 
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Be sure to check that the DM_CLIENT.kml appears in the AgentSetup/preloadedKMs variable of 
the pconfig database for the PATROL Agents that are running on the performance clients. For 
detailed information about how to verify client pre-loading, see the PATROL Agent Reference 
Manual. 

Installing Manageware for Documentum on a Desktop Client 
Host 
Summary: In this procedure, you will install Manageware for Documentum on a Documentum 
Desktop Client host. If you have a PATROL Console  installed on your Desktop Client host, you 
can also install the Manageware for Documentum Console KM on the client at the same time. 
Before You Begin 
• The client installation supports Microsoft Windows NT and Microsoft Windows 2000 only. 
• The PATROL Agent and Console must be installed and running. 
• The Documentum Client must be installed on the client machine 
• The dmcl.ini file must be pointed to the Documentum server host where the client will be 
configured. 
Confirm that $PATROL_HOME Exists 

» Confirm that the %PATROL_HOME% environment variable exists. 
You can use the echo command at the Windows command prompt to 
make this verification. 
Example 
C:\>echo %PATROL_HOME% 
\PROGRA~1\BMCSOF~1\Patrol~1 
Note 
%PATROL_HOME% is the Windows NT/2000 environment variable that identifies the home 
directory for all PATROL files. 
 
Download/Obtain PATROL for Documentum 
Download/Obtain the Manageware for Documentum files from ESI, if you haven’t already, and 
extract them to a temporary installation directory. 
 
Step 1 Create a temporary installation directory on a local drive and record the location. 
Table 2-5 Record the Temporary Installation Directory 
Note 
If you record the location of your temporary installation directory, you 
will be able to uninstall the product later if you decide to change your 
installation. 
Step 2 Untar or Unzip the file. 
 
Configuring Manageware for Documentum 3-1 

3 
Chapter 3 

Configuring Manageware for Documentum 3 
After you have installed PATROL for Documentum, you must configure the product.  
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Configuration Task Summary 
 

 
 
To configure PATROL for Documentum, perform the following tasks: 
1. Complete the pre-configuration checklist. 
2. Load the Manageware for Documentum KM list file into the PATROL Console. 
3. Configure eContent Servers for monitoring. 
4. Select Docbases for monitoring. 
5. Add Desktop Clients for monitoring. 
6. Check for SNMP port conflicts. 
7. Ensure the client has been installed and DM_CLIENT.kml is loaded. 
8. Verify discovery  

Pre-configuration Checklist 
While configuring PATROL for Documentum, you are required to enter or verify certain 
information. Use Table 3-1 to gather and record the necessary information before you start. 
 
Documentum Information For Example Your Information 

 

Loading PATROL for Documentum 
Summary: After you install PATROL for Documentum, you must load it into the 
PATROL Console. In this procedure, you will load the eContent Server components into the 
PATROL Console. If you have also installed the Desktop Client, you will load those components, 
too. 
Before You Begin 
The PATROL Agent and PATROL Console must be installed and running. 
 
To Load PATROL for Documentum 
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Step 1 From the PATROL Console menu, choose File => Load KM . The Load KMs dialog 
opens. 
Figure 3-1 Loading PATROL for Documentum 

 
Step 2 Select the DM_DOCUMENTUM.kml file. 
 
Step 3 If you have installed Desktop Clients, you can also select the 
DM_CLIENT.kml file at the same time. 
Note 
If you install the Manageware for Documentum Console components on a system where you have 
installed the client, the Console will not display icons correctly. 
Step 4 Click Open. 
Step 5 Choose File => Save KM to save the loaded KMs. PATROL automatically loads those 
KMs the next time you start the PATROL Console. 

Configuring the Documentum KM to Monitor eContent Servers 
Summary: This task describes how to configure Manageware for Documentum to monitor 
Documentum servers. 
 
Before You Begin 
• The PATROL Agent and the PATROL Console must be installed and running. 
• The PATROL KM must be loaded. See “Loading PATROL for Documentum. 
 
To Configure a Documentum Server 
Step 1 From the PATROL Console Desktop, locate the Documentum Main Map container of the 
server you want to configure. 
 
Figure 3-2 shows the Documentum Main Map container highlighted for a server. 
Figure 3-2 Main Map of eContent Server 
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Step 2 Right-click the Documentum Main Map container and choose 
Configuration => Manageware for Documentum Setup. 
The Documentum Configuration dialog opens as in Figure 3-3. 
 
Step 3 Enter all information requested in the Documentum Configuration dialog, shown in the 
example in Figure 3-3 below. 
Use the information you gathered in the “Pre-configuration Checklist” on 
Figure 3-3 Documentum Configuration Dialog Box 
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Note 
Use the table below to help you provide the information required in the Documentum 
Configuration dialog. 
Table 3-2 Manageware for Documentum eContent Server Configuration 
In Configuration field named... Provide this information... 

 

 
 
 
If the Documentum Account Password Changes or Expires 
As discussed above, Manageware for Documentum requires a specific  Documentum account to 
perform IDQL queries against Docbases and to communicate with the DocBroker. 
Also shown in the procedure above, the Documentum account is specified to the KM using the 
Configure dialog, and the user name and password of the account are stored in the PATROL 
pconfig database (the  password is DES-encrypted). 
If the password for this account expires or is changed, reset the account by using the 
Configuration => Update menu command. 
 
Choosing Docbases to Monitor 
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Summary: This task describes how to choose which locally discovered Docbases you are going 
to monitor. 
To Choose Docbases for Monitoring 
Step 1 From the PATROL Console Desktop, locate the Documentum Main Map container of the 
server you want to configure. 
Figure 3-2 shows the Documentum Main Map container highlighted for a 
server. 
Figure 3-4 Main Map of eContent Server 

 
Step 2 Right-click the Documentum Main Map container and choose 
Configuration => Toggle Docbase Monitoring. 
The Toggle Docbase Monitoring dialog opens as in Figure 3-5. 
Figure 3-5 Toggle Docbase Monitoring Dialog Box 

 
 
 
 
Step 3 Highlight the Docbases you want to monitor and click Accept. 
Manageware for Documentum configures the Docbases for monitoring. 

Adding and Removing Client Hosts 
Summary: If you have installed the Documentum KM on your Desktop Clients, you need to add 
performance clients to the Manageware for Documentum environment. This task describes how 
to define a performance client to a target server so that the client can check performance data 
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between the  server and itself. This task also describes how to remove performance clients from 
the system. 
 
Before You Begin 
• The PATROL Agent and the PATROL Console must be installed and running. 
• The PATROL Console KM for Manageware for Documentum must be installed and running. 
• The client components of the Manageware for Documentum KM must be loaded in the client 
computer’s PATROL Agent.  
 
To Add Client Hosts 
Step 1 From the PATROL Console main window, open the Documentum Main Map container of 
the target server where you want to add a client host. 
Step 2 Right-click the PERFORMANCE icon to access the menu commands. 
Step 3 Choose Client Hosts. 
Step 4 Enter the name of the client host you want to add in the “Client Host Name to Add” field. 
Step 5 Enter a label name in the “Host Label” field so that you can distinguish the client name 
from others. 

 
Step 6 Click Accept to save your changes. At the next discovery cycle, the new performance 
client will appear in the console with its host label, if you provided one. You can also click 
Cancel to return to the console without adding a performance client. 
 
To Remove Client Hosts 
Step 1 From the PATROL Console main window, open the Documentum Main 
Map container of the target server where you want to add a client host. 
Step 2 Right-click the PERFORMANCE icon to access the menu commands. 
Step 3 Choose Client Hosts. 
 
The Define Client Hosts dialog opens. 
 
Step 4 Highlight the name of the client host you want to remove from the “Select Client Hosts to 
Remove” field. 
Step 5 Click Accept to remove the client host. Click OK at the Confirmation dialog, or Cancel 
to refrain from deleting the selected client. A confirmation box gives you the option of 
confirming or changing your choice. 
 

Checking for SNMP Port Conflicts 
Summary: If you are running multiple PATROL Agents on your Documentum eContent Server, 
or other third-party applications that use the SNMP protocol, you need to check whether you have 
conflicting SNMP port settings. 
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If you do, you can use this procedure to change the default and trap SNMP ports on the Agent 
that will be running Manageware for Documentum – eContent Server as well as the Agent 
running remote performance clients. 
 
Why You May Experience SNMP Port Conflicts 
The Manageware for Documentum – eContent Server KM monitors only one DocBroker at a 
time per Documentum server. The server uses the SNMP protocol to collect performance data 
from multiple performance clients. Consequently, an SNMP port needs to be available for the 
server and its clients to communicate with each other. If the default port is already taken, you can 
choose a different port to use, matching clients and servers to the same port. If you are running 
multiple PATROL Agents on a Documentum eContent Server, you must change the default 
SNMP port on the Agent that will be running the eContent Server KM and monitoring remote 
performance clients. 
 
Note 
The Documentum Server KM can monitor all Docbases that the DocBroker knows about. 
 
To Change the SNMP Default and Trap Ports on a Documentum Server 
You can use the agent configuration utility for your operating system to change the SNMP port 
that a PATROL Agent uses. 
 
Step 1 From your developer console, right-click the target host machine to access the menu 
commands and choose Development => Agent Configuration. 
 
A wpconfig or pconfig window opens. The examples illustrate wpconfig.  
 
Step 2 Locate the SNMP folder in the left-hand pane and double-click to open it. 
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Step 3 Highlight the default_port variable and double-click to open it. If you are using this 
procedure to change the trap port, highlight the trap_port variable instead. 
 
Figure 3-6 Changing the Default Port 

 
 
Figure 3-7 Changing the Trap Port 
 
 
 

 
 
Step 4 At the Modify Variable dialog, double-click the “Replace =” line to open the Change 
Entry dialog. 
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Step 5 At the Change Entry dialog, edit the value to change the port to something other than the 
default, and click OK. The example shows a change from 161 to 1161. 

 
 
Step 6 At the Modify Variable dialog, verify that the REPLACE = entry shows the new port 
assignment, and click OK. 
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Step 7 From the menu bar of the wpconfig window, choose Tools => Apply Configuration. 

 
 
 
Step 8 At the Apply Configuration dialog, highlight the host name whose configurations you 
want to save and click OK. 
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Step 9 At the Wpconfig warning dialog, confirm your changes by clicking Yes. Click No to 
return to the Apply Configuration dialog and select a different host. 
Step 10 Re-initialize the PATROL Agent. If you do not re-initialize the Agent, your changes 
will not be applied. 
Step 11 Repeat this procedure from Step 3 to make changes to the SNMP trap port. 

 
 
 
To Change the SNMP Port on a Desktop Client Using pconfig or wpconfig 
Now that you have changed the SNMP default and trap ports on the Documentum server, you 
need to make the same port changes to the client machines that they communicate with. 
 
Step 1 Launch a PATROL Developer Console from your client machine. 
 
Step 2 Repeat the procedure in “To Change the SNMP Default and Trap Ports on a Documentum 
Server”. Make sure that you use the same port numbers for the client that you specified for the 
server default and trap ports. 
 
Warning 
To communicate via SNMP, the server and client must use the same default port and trap port. 
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Step 3 Re-initialize the PATROL Agent. 

Verifying Discovery 
Summary: This task describes how to verify that the Manageware for Documentum KM has 
discovered all Documentum servers. The PATROL KM automatically discovers all Documentum 
servers during the configuration process. The PATROL KM also creates an icon at the top level, a 
Docbase container icon under that, and then an icon under the Docbase container for each 
Docbase known to the DocBroker running on that eContent server. 
 
Before You Begin 
• The PATROL Agent and PATROL Console must be installed and running. 
• The Manageware for Documentum product must be loaded and configured. Under the 
DOCUMENTUM_MAIN container, icons will be displayed for COLLECTORS, DATABASE, 
DOCBASES, DOCBROKERS, and PERFORMANCE. 
 
To Verify Discovery 

» Verify that each Documentum server that you specified during configuration is represented 
by an icon and that the five application icons listed above are displayed. 

4 
Chapter 4 
Using Manageware for Documentum 4 
Use the following procedures to monitor your Documentum environment: 

Monitoring Database Availability and Performance 
Summary: Manageware for Documentum can monitor key database parameters from 
information retrieved from Documentum. 
 
Note 
Manageware for Documentum gathers database statistics from the eContent server, which gathers 
the information from the database. Documentum may not display all of these parameters for all of 
its supported databases. 
 
Task Steps 
Step 1 From the PATROL Console main map window, Open the icon labeled 
DM_DOCUMENTUM Main Map hostname, the name of the target eContent Server. 
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Step 2 Open the DATABASE Container icon. 
Step 3 Open the icon for the Docbase you want to monitor. 
Step 4 Open the parameters in alarm and use their parameter descriptions to isolate the problem. 
 
The DBConnectStatus parameter reports the status of the connection to the database. You can 
find detailed information about all the Database parameters in, “Parameter Summary.” You can 
also right-click the target parameter and select Help On. Or, “Parameter Summary.” 

Monitoring Docbase Availability and Performance 
Use the information in this section to make sure that your Docbases are running and have not 
been dropped from the list of known Docbases to monitor. You can also use this information to 
help prevent Docbases from being dropped from the DocBroker’s list of known Docbases to 
monitor. 
 
The Role of the DocBroker 
Manageware for Documentum communicates with the Documentum DocBroker to obtain a list of 
its known Docbases. 
 
A Documentum DocBroker, which is shown as a DM_BROKER application class instance, 
functions like a clearinghouse of Docbases. Clients normally perform operations against a 
Docbase through a DocBroker. The DocBroker keeps track of its set of Docbases and periodically 
receives information from them. 
 
The list of known Docbases is requested from the DocBroker at every PATROL discovery cycle 
and the resulting Docbases are monitored by PATROL for Documentum. 
 
Gathering Docbase Information 
Discovered Docbases are created in the application class tree under the DM_DOCBASE_CONT 
container, labeled DOCBASES. At this level, all of the Docbase parameter instances will be 
shown and labeled using the Docbase names returned by the DocBroker. Each Docbase 
constitutes a container (the DM_DOCBASE_CONT class), which includes the following classes 
for each Docbase: 
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Docbase Availability Scenarios 
Specific Docbase availability information is found under the container labeled DOCBASE 
(DM_DOCBASE class). The following situations illustrate their use: 
 
The Documentum operator wants to verify that a Docbase has not been dropped from the 
DocBroker’s list of known Docbases.  
This can be monitored using the Checkpoint parameter, which tracks the time that has elapsed 
since the DocBroker received information from the Docbase. The related parameter, Keep Entry, 
tracks the percentage of time that has been used—if a Docbase has not communicated with a 
DocBroker—out of the total time a DocBroker will wait before dropping a Docbase. The formula 
for making this calculation is: 
Keep Entry = (Checkpoint / Docbase Keep Entry Interval) * 100 
 
Using these, the appropriate alarms can be set, taking into consideration the Documentum-
configured Keep Entry interva l. 
Per-Docbase Class Description 
 
The Documentum operator wants to verify that the status of the 
Docbase is still “Open” 
The Status parameter is set to 0 (OK) if the DocBroker responded with a 
Server Status: Open to the query. 
 
The Documentum operator wants to see the impact of the 
DocBroker process on the system 
The following process-related parameters apply to the DocBroker process only. At this time, the 
Manageware for Documentum KM displays them under each DM_BROKER. 
 
• docbrokerCount 
This parameter reports the number of concurrent “DocBroker” processes running on the 
Documentum server. This parameter is mined from the dm-docbroker parameter in the UNIX 
KM. 
• docbrokerCPU 
This parameter reports the percentage of CPU utilized by all of the “DocBroker” processes 
running on the server. This parameter is mined from the dm-docbroker parameter in the UNIX 
KM. 
• docbrokerMEM 
This parameter reports the total memory utilized by all of the “DocBroker” processes running on 
the server. This parameter is mined from the dm-dm-docbroker parameter in the UNIX KM. 
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Checking End-to-End Response Time Between Documentum 
Clients and Docbases 
Manageware for Documentum measures perceived end-user performance. End-user performance 
is approximated using stand-alone executables that perform operations against Docbases from 
Documentum client machines. This functionality is currently supported on Windows NT (for 
clients), and is referred to here as performance clients. The information in this section gives an 
overview of the considerations involved in setting up performance clients on your system. 
 
How Performance Clients Work 
The client executables perform standard operations through API calls to Documentum using a 
dummy document. The time it takes for these operations to complete processing is recorded, thus 
giving a measure of perceived end-user performance. 
The following operations are performed against a Docbase in the Temp cabinet: 
• Connect 
• Import 
• Check in 
• Check out 
• Delete 
Current Capabilities and Limitations 
• A client will attempt to perform operations against all known Docbases for a DocBroker host. 
• A performance client can only be configured to communicate with a single DocBroker host. 
 
Client Configuration 
The client can use one account to do this, so the account must be either in a federation or defined 
on all Docbases for a DocBroker host, if remote client performance is to be measured against 
these Docbases. The account used is the same as the account entered in the server configuration, 
under the IDQL account label. 
 
Clients can be set up on Windows NT machines that contain: 
• A correctly configured Documentum Client, pointing to the eContent Server host 
• A PATROL Agent 
• The client component of Manageware for Documentum Once a client host has been set up and 
configured, only then can it be added to the system by the server component of PATROL for 
Documentum, using the Client Hosts menu command of the DM_PERFORMANCE class. 
 
Communication between Client and Server 
Agent-to-agent communication between client and server is implemented using the SNMP 
protocol, so the operator must make sure of the following: 
• The SNMP port is available. 
• The PATROL SNMP agent is running on both the server and client. 
Type %PSL print(get(snmp_agent_config()))in the system output window to determine 
if the PATROL SNMP agent is running on both the server and client. 
• If there is another application using the SNMP default ports 161 and 162, these can be 
reconfigured in the PATROL Agent. If this is done, both client and server must use the same 
SNMP port numbers. 
• SNMP ports are changed through the use of the pconfig utility, by replacing the contents of the 
variables SNMP/default_port and SNMP/trap_port. 
• If the SNMP ports are changed in a PATROL Agent, re-initialize the Agent. 
 
Considerations When Adding Clients to the Performance Class 



Documentum Users Guide  34 

When a client is added under the DM_PERFORMANCE class, its PATROL Agent is configured 
using agent-to-agent communication. It is therefore important that the client host is up and 
running, and  
• the KM list file, DM_CLIENT.kml, is pre-loaded 
• the Documentum 4i dmcl.ini file is correctly configured to point to the server host 
• the Agent is online 
Multiple clients can be added to a server host under the DM_PERFORMANCE class, allowing 
for flexible monitoring, perhaps from different geographic locations against the Docbases known 
to a server. 
 
Performance Client Timing Measurements 
The following is a subset of the timings returned for each Docbase from a client. These reflect the 
time it took to perform the operations below against each of the Docbases from a particular client 
host. 
• ConnectTime 
• ImportTime 
• CheckOutTime 
• CheckInTime 
• DeleteTime 
• DisconnectTime 
• GetPerfTime (totals) 
• ConnectionStatus 
For detailed information on these parameters,  “Parameter Summary.” 

Monitoring Job Status 
Summary: Use this procedure to check on the status of Documentum jobs in each Docbase. 
 
Overview of Job Status 
To monitor job status, the Manageware for Documentum JOBS application uses the IDQL utility 
to issue queries about jobs and collect the returned data about job status. The JOBS application 
also tracks the number of completed, failed, and aborted jobs per Docbase. 
 
To Check the Status of Jobs Parameters 
Step 1 From the PATROL Console main map window, open the icon labeled 
DM_DOCUMENTUM Main Map hostname, the name of the target eContent Server.  
Step 2 Open the target Docbase Container icon. 
Step 3 Open the icon for the Docbase you want to monitor. 
Step 4 Open the JOBS icon to display its parameters. 
Step 5 Open the parameters in alarm and use their parameter descriptions to isolate the problem. 
You can find detailed information on the DM_JOBS parameters shown above by right-clicking a 
target parameter and selecting Help On. Or, see  “Parameter Summary.” 

Monitoring Process Status 
Summary: The Documentum KM monitors two key Docbase-related Documentum eContent 
Server processes: documentum and dm_agent_exec, method server. You can use the parameters of 
these process applications to monitor process status. 
 
Docbase Metrics and the documentum and dm_agent_exec, method server  Processes 
The percentage of CPU, the amount of memory used, and the number of processes that are 
running all reflect activity against a Docbase. Manageware for Documentum separates these 
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metrics by Docbase under each Docbase instance so that performance and load can be determined 
for each Docbase.  
 
The documentum process monitors process status for each Docbase and its sessions. The 
dm_agent_exec process schedules job execution. For each Docbase, ala rm thresholds can be set 
for each documentum and dm_agent_exec, method server process. You can use the parameters of 
these Process applications to monitor process status. 
 
To Monitor Process Status 
Step 1 From the PATROL Console main map window, open the icon labeled 
DM_DOCUMENTUM Main Map hostname , the name of the target eContent Server. 
Step 2 Open the target Docbase container icon. 
Step 3 Open the icon for the Docbase you want to monitor. 
Step 4 Open the PROCESSES icon to display the AGENT_EXEC or DOCUMENTUM or 
METHOD SERVER process icons. 
 
Note 
The parameters shown reflect performance metrics for the processes associated with the current 
Docbase in the hierarchy. 
 
Step 5 Open the AGENT_EXEC or DOCUMENTUM or METHOD SERVER process icons to 
display their parameters. 
Step 6 Open the parameters in alarm and use their parameter descriptions to isolate the problem. 
 
You can find detailed information on the DM_PROCESS parameters shown above by right-
clicking a target parameter and selecting Help On. Or, see  “Parameter Summary.” 

Monitoring File System Capacity 
Summary: Use this procedure to monitor details about available space, capacity and used 
capacity for the file stores in use by each Docbase. 
 
DM_FILESTORE Hierarchy and Parameters 
The FILESTORE family of classes present a hierarchy with the file store name above the file 
store path, and includes the following parameters: 
• FSAvailableSpace 
• FSCapacity 
• FSUsedSpace 
The data is acquired in two steps: 
• Query the Docbase for file store information (IDQL). 
• Get file system information. 
Figure 4-1 Example Hierarchy of a Documentum KM File Stores 
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To Monitor File System Capacity 
Step 1 From the PATROL Console main map window, open the icon labeled 
DM_DOCUMENTUM Main Map hostname, the name of the target eContent Server. 
Step 2 Open the Docbase container icon. 
Step 3 Open the icon for the Docbase you want to monitor. 
Step 4 Open the FILESTORE_CONT icon. 
Step 5 Open a FILESTORE icon. 
Step 6 Open the parameters in alarm and use their parameter descriptions to isolate the problem.  
 
You can find detailed information on the FILESTORE parameters shown by right-clicking a 
target parameter and selecting Help On., “Parameter Summary.” 
 
Note 
The values reported are gathered from Documentum and may differ slightly from the values 
gathered through file system Unix utilities. The space used is that used by non-orphaned objects 
in the database. 

Tracking User Activity 
Summary: The Users application class sends queries to the Docbase that retrieve information 
about users and user sessions. The information gathered includes information about user activity 
and a current list of users. Use this procedure to monitor Docbase user activity. 
Task Steps 
Step 1 From the PATROL Console main map window, open the icon labeled 
DM_DOCUMENTUM Main Map hostname, the name of the target eContent Server. 
Step 2 Open the Docbase Container icon. 
Step 3 Open the icon for the Docbase you want to monitor. 
Step 4 Open the USERS container icon. 
Step 5 Open the parameters of interest. 
You can find detailed information on the DM_USERS parameters shown above by right-clicking 
a target parameter and selecting Help On. Or, see , “Parameter Summary.” 
 
Displaying a List of User Sessions 
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Summary: Using this procedure, you can display a text list of all user sessions 
Task Steps 
1. Open the icon labeled DM_DOCUMENTUM Main Map hostname, the name of the target 
eContent Server. 
2. Open the DOCBASES container. 
3. Open the icon for the Docbase you want to monitor. 
4. Right-click the USERS instance icon, and choose KM Commands => User List. 
A list of user sessions is displayed. 

Identifying Problem Users 
Summary: The DM_PROCESS application class also contains information that can help you 
track problem users. Manageware for Documentum allows you to identify user sessions that are 
causing excessive CPU consumption. Use this procedure to identify problem users. 
Task Steps 
Step 1 Using the DM_PROCESS class, identify the Docbase which is consuming excessive 
resources (for example, an excessive percentage of CPU, amount of memory, or number of 
processes). 
Step 2 Look at the process table in the eContent Server host using Unix command ps -ef | 
grep documentum 
Step 3 From the resulting list of process IDs, identify the process ID that belongs to the problem 
Documentum process. 
Step 4 Generate a User List report using the User List KM command, as described in 
“Displaying a List of User Sessions”  
Step 5 In the generated list, search for the process ID, and then you can identify the user name 
and host name of the problem user. 
 

Using dmclean to Remove Orphaned Content 
Summary: The dmclean utility is commonly used by Documentum administrators as part of their 
regular maintenance of Documentum systems. It is used for removing orphaned content objects 
and files. Performance clients in Manageware for Documentum also can create orphaned files. 
 
Performance Clients Simulate End-user Response  
Performance clients, which, run automated operations against each monitored Docbase to obtain 
end-user response timings. These operations are run against the Temp cabinet, and include the 
following Documentum operations: 
• Import 
• Delete 
• Check in 
• Check out 
 
Why Objects Need To Be Removed with dmclean 
Depending on collector parameter scheduling and the schedules chosen for performance clients, 
there could be a significant number of deleted objects that still remain to be cleaned up. This is 
because in Documentum, deleting a document does not remove the content files or content 
objects associated with it. Consequently, it is recommended that you execute the dmclean utility 
regularly. See the Documentum eContent Server Administrator’s Guide for more information on 
dmclean. 

5 
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Chapter 5 

Menu Summary 5 
This chapter summarizes the application menus and menu commands defined for PATROL for 
Documentum.  
 

Overview 
The application menu architecture is provided in a table for each of the application classes that as 
menu commands. When you load a PATROL KM, its associated menu commands are added to 
the KM area of a menu. (Not all KM applications have menu commands.) 
 
• With the PATROL Console for Unix, the KM area of a menu is below the menu’s horizontal line. 
Menu commands above the line belong to the console. 
• With the PATROL Console for Windows NT, KM menu commands are accessed through the 
PATROL Console menu command KM Commands . 
 
To access an application menu, right-click the application class icon. 
• With the PATROL Console for Unix, choose a menu command and follow the menu tree. 
• With the PATROL Console for Windows NT, choose KM Commands  and follow the menu tree. 
This chapter describes PATROL KM menu commands only. For descriptions of console menu 
commands, see the PATROL user guide for your console. 

eContent Server Menu Summary 
This section summarizes the application menu commands defined for Manageware for 
Documentum – eContent Server. 
The starting point for accessing all commands in this section is from the 
PATROL Main Map icon “DM_DOCUMENTUM Main Map hostname.” This icon, shown 
highlighted in Figure 5-1, represents the target Documentum eContent Server. 
 
Figure 5-1 Manageware for Documentum Main Map 
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DM_DOCUMENTUM Menu 
To access the DM_DOCUMENTUM menu 
Table 5-1 describes the DM_DOCUMENTUM menu commands used by the Documentum KM. 

 
1. Open the icon labeled DM_DOCUMENTUM Main Map hostname, the name of the target 
eContent Server. 
2. Right-click the target Docbase icon. 
3. Choose KM Commands. 
 

Client Performance (DM_PERF_CLIENT) Menu 
To access the DM_PERF_CLIENT menu 
1. Double-click the icon labeled DM_DOCUMENTUM Main Map hostname, the name of the 
target eContent Server. 
2. Double-click the PERFORMANCE container icon. 
3. Right-click a client performance instance icon 
(DM_PERF_CLIENT), and choose KM Commands. 
 
. 

Performance Container (DM_PERF_CONT) Menu 
To access the DM_PERF_CONT menu 
1. Double-click the icon labeled DM_DOCUMENTUM Main Map hostname, the name of the 
target eContent Server. 
2. Right-click the PERFORMANCE container icon, and choose KM Commands. 
. 

Users (DM_USERS) Menu 
To access the DM_USERS menu 
1. Double-click the icon labeled DM_DOCUMENTUM Main Map hostname, the name of the 
target eContent Server. 
2. Double-click the DOCBASES container. 
3. Double-click the target Docbase icon. 
4. Right-click the USERS instance icon, and choose KM Commands. 
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Desktop Client Menu Summary 
This section summarizes the application menu commands defined for 
Manageware for Documentum – Desktop Client. 
 

Client (DM_CLIENT) Menu 
To access the DM_CLIENT menu 
1. Double-click the icon that represents your desktop client. 
2. Right-click the desktop client icon. 
3. Choose KM Commands. 
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Chapter 6 

Parameter Summary 6 
This chapter provides a summary of parameters for PATROL for Documentum. The online Help 
system provides further details about the parameters. 
For information about the different types of parameters and their functions, see the user guide for 
your PATROL Console. 

Parameter Summary by Application 
Manageware for Documentum contains various parameters that provide statistical information 
about resources, operating status, and performance. 
 
The Table  provides descriptive information for each parameter that belongs to an application. 
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Parameter Summary by Collector Class 
This table organizes the Manageware for Documentum parameters based on the collector that 
provides their values. 
Table 6-2 Parameter Summary by Collector Class 
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Parameter Property Definitions and Default Values 
This section briefly describes certain parameter properties, such as whether the parameter is 
active or inactive, whether an alarm or border range has been set, and the time interval in the 
polling cycle. For more information about the meaning of these and other properties, refer to the 
PATROL User Guide for your console. Table 6-3 contains parameter default values for each of 
these properties. 
 

Property Definitions 
The following property definitions explain the meaning of each column heading in Table 6-3. 
 
Parameter Specifies the parameter name. 
 
Active? Specifies whether the parameter is active or inactive when discovered. 
 
Type Specifies whether the parameter is a standard (std), consumer (con), or collector (Coll) 
parameter. 
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Border If it is possible for the parameter to return a value outside of the Alarm 1 range or the 
Alarm 2 range, specifies thresholds for a border range of values. The border range is used either 
as information or as a third-level alarm that represents either a warning or an alarm state. This 
information is not applicable to collectors. 
 
Alarm1 Specifies thresholds for the first-level alarm which represents either a warning or an 
alarm state. This information is not applicable to collectors and standard parameters that serve as 
collectors. 
 
Alarm2 Specifies thresholds for the second-level alarm which represents either a warning or an 
alarm state. This information is not applicable to collectors. 
 
Scheduling Specifies the time interval in the polling cycle for collectors.  
 
Consumer parameters show the values inherited from their collector parameter. 

 

Parameter Default Values Listed Alphabetically 
The table provides property default values for each parameter. Parameters are presented 
alphabetically. If information is not applicable  for a parameter, it is denoted by N/A. If a 
parameter alarm range has not been set, it is denoted by Undef(ined) in the table. 
 
Icon If the parameter has output, specifies whether the icon represents a graph, a gauge, text 
output, a Boolean state, or a stoplight. 
 
Units Specifies the type of unit in which the parameter output is expressed, such as a 
percentage, a number, or bytes. 
 
History Level Specifies the history retention period. This information is not applicable to collector 
parameters 
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Appendix A. Agent Setup Variables A 
The Agent Setup Variables for Manageware for Documentum can be viewed by clicking on the 
computer icon on which the Documentum Agent KM is installed and then clicking on 
Development => Agent Configuration.  
 
These values are provided as examples only. The values in your system will be different. The 
variables in this list are set by Manageware for Documentum and are provided here as a 
reference. 
 
Table A-1 Agent Configuration Variables for Manageware for Documentum - eContent Server 
Components 
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Appendix B.  

Manageware for Documentum Installation and Configuration 
Troubleshooting B 
This appendix lists and describes the common error messages and other problems you may 
encounter when installing or configuring PATROL for Documentum. 

Problem Resolution 
The information in this section should be used to help you to determine the cause of problems 
you may experience when installing, configuring and starting PATROL for Documentum. If this 
information does not resolve the problem, consult BMC Software Customer Support. 
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General Issues 
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Database Collection Issues 

 
 

File Store Issues 
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Client Issues 
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C 
Uninstalling Manageware for Documentum C 
If you decide to change the server or client on which you want to install the Documentum KM, or 
if one or more parts of your installation is unsuccessful, you must remove that KM component 
from its computer before you can reinstall it. You do not need to uninstall PATROL, you only 
need to uninstall the Manageware for Documentum KM. In general, you can uninstall a KM by 
following the instructions that are provided in the PATROL Installation Guide. There are some 
Manageware for Documentum files, however, that are not known to the Common Installer, and 
these must be manually deleted. 
To Uninstall PATROL for Documentum 
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Step 1 Follow the instructions for uninstalling a knowledge module that are found in the 
PATROL Installation Guide, using the directory locations you saved in Chapter 2, “Installing 
PATROL for Documentum.” 
Step 2 Manually delete the $PATROL_HOME/lib/DM_Server directory and its contents. Also 
Delete from the PSL directory dm_*.lib and DM_*.lib  Delete from the Knowledge directory 
DM_*.* 
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